Patient Assessment Documentation Package (PADP)

C3-C1 Conversion Project

Admission - Nursing Data Collection User Manual for NUPA Version 1.0

April 2012

Department of Veterans Affairs
Office of Information and Technology (OIT)
Office of Enterprise Development (OED)
# Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 2010</td>
<td>1.0</td>
<td>Initial version for v1.0 Split Assessment manual into two manuals</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Admissions – RN Assessment User Manual</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Nursing Data Collection User Manual</td>
<td></td>
</tr>
<tr>
<td>January 2011</td>
<td>1.1</td>
<td>• Changed dates to January 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated with additional comments from Judy</td>
<td></td>
</tr>
<tr>
<td>February 2011</td>
<td>1.2</td>
<td>• Changed dates to February 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td>March 2011</td>
<td>1.3</td>
<td>• Changed dates to April 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated with Judy’s comments</td>
<td></td>
</tr>
<tr>
<td>April 2011</td>
<td>1.4</td>
<td>Updated RoboHelp with this file</td>
<td>REDACTED</td>
</tr>
<tr>
<td>May 2011</td>
<td>1.5</td>
<td>• Changed dates to May 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added (NUPA*1) namespace</td>
<td></td>
</tr>
<tr>
<td>October 2011</td>
<td>1.6</td>
<td>• Added C3-C1 Conversion Project</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed dates to October 2011</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prepped for national release</td>
<td></td>
</tr>
<tr>
<td>November 2011</td>
<td>1.7</td>
<td>• Changed dates to November 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated for build v14</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed dates to December 2011</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated for build v15</td>
<td></td>
</tr>
<tr>
<td>December 2011</td>
<td>1.8</td>
<td>• Changed dates to December 2011</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed Admission – RN Reassessment to RN Reassessment</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated for build v15</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated for new assessment executables</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed dates to January 2012</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prepped for national release</td>
<td></td>
</tr>
<tr>
<td>January 2012</td>
<td>1.9</td>
<td>• Changed NUPA 1.0 to NUPA Version 1.0</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated for build v16</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed dates to February 2012</td>
<td></td>
</tr>
<tr>
<td>February 2012</td>
<td>2.0</td>
<td>Updated the Vitals tab</td>
<td>REDACTED</td>
</tr>
<tr>
<td>Date</td>
<td>Revision</td>
<td>Description</td>
<td>Author</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>--------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>March 2012</td>
<td>2.1</td>
<td>• Changed dates to March 2012</td>
<td>REDACTED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prepped for April national release</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed dates to April 2012</td>
<td></td>
</tr>
</tbody>
</table>
Table of Contents

Introduction ................................................................................................................................... 1

Using Admission – Nursing Data Collection ........................................................................... 2
  Opening Admission – Nursing Data Collection ................................................................. 2
  No Previously Saved Information ....................................................................................... 3
  Previously Entered Information Available for One Patient ............................................. 3
    Restore Patient’s Data/No ............................................................................................. 3
    Restore Patient’s Data/Yes .......................................................................................... 4
  Previously Entered Information Available for Two or More Patients ............................... 4
    View the Patients?/No .............................................................................................. 4
    View the Patients?/Yes ............................................................................................. 5
    Patient on the List ..................................................................................................... 5
    Patient not on the List .............................................................................................. 5
  Patient not yet Assigned to an Inpatient Bed ................................................................... 6

Saving and Uploading Data ...................................................................................................... 7
  Auto Save ......................................................................................................................... 7
  Manual Save ..................................................................................................................... 7
  Upload Data ....................................................................................................................... 7
  Save and Exit ....................................................................................................................... 8
  Save Now ............................................................................................................................ 8
  Exit ................................................................................................................................... 9
  Signing Notes ..................................................................................................................... 9

Working in the Template .......................................................................................................... 10
  Moving through the Template with a Mouse ................................................................. 10
  Moving through the Template without a Mouse ............................................................ 11
    Ctrl-Alt Keys ............................................................................................................... 11
    Go to radiogroup ......................................................................................................... 12

Navigating the Admission - Nursing Data Collection Tabs ....................................................... 13
  Belongings (Belong) ......................................................................................................... 13
  Orientation to Unit (Orient) ............................................................................................ 18
  Vital Signs (V/S) ............................................................................................................ 20
  View Text (View Text) .................................................................................................... 28
    Signing Note and Consults from within the Template .............................................. 28

Glossary ....................................................................................................................................... 30
Introduction

The Patient Assessment Documentation Package (PADP) Version 1.0 is a Veterans Health Information Systems and Technology Architecture (VistA) software application that enables Registered Nurses (RNs) to document, in a standardized format, patient care during an inpatient stay. Although the content is standardized for use across the VA system, some parameters can be set to support the unique processes at individual medical centers.

PADP interfaces directly with several VistA applications, including Computerized Patient Record System (CPRS), Clinical Reminders, Consult Tracking, Allergy/Adverse Reaction Tracking, Mental Health Assistant, Vitals, and Patient Care Encounter (PCE).

PADP is a Delphi application, which supports RNs in documenting patient care during an inpatient stay. It includes the following templates:

- Admission – RN Assessment allows RNs to document the status of the patient at admission.
- Admission – Nursing Data Collection allows Licensed Practical Nurses (LPNs) and other nursing staff, including the RN, to enter basic patient data, such as vitals and belongings at the time of admission.
- RN Reassessment allows RNs to document the condition of the patient on a regular basis and any time during the inpatient stay.
- Interdisciplinary Plan of Care interfaces with admission and reassessment data, and allows additional information to be entered by the RN and other health care personnel (physicians, social workers, chaplain, etc.). All clinical staff can enter information into the Plan of Care. The Plan of Care can be printed and given to the patient when appropriate.

PADP consists of a KIDS build, NUPA 1.0, and four (4) Delphi GUI templates in three executables.
1. The executable, `Admassess.exe`, contains the Admission - RN Assessment template and the Admission - Nursing Data Collection template.
2. The executable, `Admassess_Shift.exe`, contains the RN Reassessment template.
3. The executable, `Admassess_Careplan.exe`, contains the Interdisciplinary Plan of Care template.

Each template is associated with a note.
- The Admission - RN Assessment template is associated with the note: **RN Admission Assessment**
- The Admission - Nursing Data Collection template is associated with the note: **Nursing Admission Data Collection**
- The RN Reassessment template is associated with the note: **RN Reassessment**
- The Interdisciplinary Plan of Care template is associated with the note: **Interdisciplinary Plan of Care**

PADP adds to VistA, a new namespace (NUPA), four (4) Progress Notes, five (5) printouts, fourteen (14) files, thirty-six (36) parameters, and new health factors. The 5 printouts are:
1. The Daily Plan® is a health summary designed to be given to the patient and family
2. Plan of Care is a plan designed to guide the nursing staff
3. Discharge Plan is for discharge planners
4. Belongings is a list of patient belongings
5. Safe Patient Handling is designed to guide the transfer of a patient
Using Admission – Nursing Data Collection

The Data Collection tabs contain information that is collected by any nursing personnel. This information is located on tabs: Belongings, Orientation to the Unit, and Vital Signs.

Opening Admission – Nursing Data Collection

You access the Admission -Nursing Data Collection through CPRS from the Tools menu.
1. Open CPRS.
2. Select a patient.
3. Click Tools.
4. Select Data Collection.
   Enter a patient window automatically opens to the CPRS patient.

   Note: You may have to re-enter your CPRS access and verify codes, depending on local site setup.
No Previously Saved Information

The Enter a patient window displays.

```
1. Select an Assessment Type.
2. Click Start Note.
   The nursing data collection template opens to the Belongings tab for the CPRS patient.
```

Previously Entered Information Available for One Patient

```
Patient selection window with previously entered information available for one patient

Restore Patient’s Data/No

If you previously entered data on one patient, you are prompted with: You have previously saved data on a note for patient <PADPPATIENT,ONE>
```

1. Select an Assessment Type.
2. Select No.
The patient’s information is deleted, but the Internal Entry Number (IEN) for the patient displays in the Enter a patient text box.

3. Click Start Note.
The template opens to the Belongings tab and you can enter new data for that CPRS patient.

4. Optional: You can delete the IEN of that CPRS patient, enter the name of a different patient, and click Start Note.

   **Note:** The Internal Entry Number (IEN) is a unique, computer-generated number that identifies a specific patient in your system. The IEN has no impact on the completed assessment, nor does it display again.

**Restore Patient’s Data/Yes**

If you previously entered data on one patient, you are prompted with: *You have previously saved data on a note for patient <PADPPATIENT,ONE>*

1. Select an Assessment Type.
2. Select Yes.
3. Click Start Note.
   The template opens to the Belongings tab for the CPRS patient with the data restored.

**Previously Entered Information Available for Two or More Patients**

If you have previously stored data from more than one patient, you are asked if you want to view a list of those patients.

**View the Patients?/No**

If you select No, the patient’s name displays in the Enter a patient text box as a number that identifies the CPRS patient.

1. Select an Assessment Type.
2. Click Start Note.
   The template opens to the Belongings tab.
Patient selection window with No selected

**View the Patients?/Yes**

1. Select **Yes**.
2. Select an Assessment Type.
   Patient Selection window displays with a list of patients with saved data.

**Patient Selection List**

**Patient on the List**

1. Select a name.
2. Click **OK**.
   The template opens to the Belongings tab.

**Patient not on the List**

1. Click **Cancel**.
   The number that represents your CPRS patient is in the Enter a patient text box.
2. Click the **Start Note**.
   The template opens to the Belongings tab.
Patient not yet Assigned to an Inpatient Bed

When a patient is not assigned an inpatient bed, a location pop-up automatically displays over the Belongings window.

1. Select a current patient location, i.e., outpatient clinic.
   Navigate quickly to the current location by entering the first letter of the location.
2. Click OK.
Saving and Uploading Data

Auto Save

Data are saved automatically. Frequency of auto save is set locally.

![Saving data: percentage saved indicator](bottom right corner of the window)

Manual Save

You can save data by using the File menu on any tab.

![Admission - Nursing Data Collection window, File menu]

Upload Data

To create a note you must upload the data into VistA and CPRS:
1. Open the File menu on any tab and select **Upload Data**.
   Results from your upload display, verifying that the data is uploaded.
**Note:** The *unsigned* note, selected consults, and PCE data/Health Factors are uploaded into CPRS and VistA.

2. If the information is incomplete, an Error Listing window displays indicating the pages within specific tabs that require attention.
   - The tabs with pages that require attention are blue.

   ![Error Listing Window](Image)

   **Admission – Nursing Data Collection, Error Listing window**

   - Once the pages are completed, the tab returns to gray.
     i. Double-click an item to go to the page that requires attention.
     ii. When all the errors are completed, select **Upload Data** again.

**Save and Exit**

To save data and temporarily leave the template:
1. Open the File menu on any tab.
2. Select **Save and Exit**.
3. When you re-open the template, your previously entered data is there.

**Save Now**

To save data, but not close the template and continue to enter data:
1. Open the File menu on any tab.
2. Select **Save Now**.
3. Continue to enter data for the current patient.
Exit

1. From any tab, click X in the top right corner of the window. Warning message displays.

![Warning pop-up: Do you really wish to exit?](image)

2. Click Yes.
3. From any tab, open the File menu and click Exit. Warning message displays.
4. Click Yes.

Signing Notes

Go to CPRS to sign your uploaded, unsigned notes.

You can also sign unsigned notes after the upload from the View Text tab in the template.

1. Click View Text.
2. Click **Sign Note/Consults**.

![Admission – Nursing Data Collection with Sign Note/Consults button](image)

3. Enter your electronic signature and click **Accept e-sig**.
4. To prevent the signing of an uploaded note, click **Cancel e-sig**.

**Working in the Template**

1. To complete the template, move through the fields from left to right and then down.
2. The active page displays first and the page tab is white.
3. Each field with an asterisk (*) must have an entry.
4. A field without an asterisk is optional.
5. You must enter optional information where appropriate for the patient.

**Moving through the Template with a Mouse**

1. Click a tab at the bottom of any of the Admission - Nursing Data Collection windows. The selected tab opens.

![Admission – Nursing Data Collection tabs](image)
2. Open the Tabs menu and select a tab from the list. The selected tab opens.

**Admission – Nursing Data Collection Tabs menu**

**Moving through the Template without a Mouse**

**Ctrl-Alt Keys**

You can move from tab to tab using Ctrl+Alt+<letter>. The list contains the keys to use for each of the tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belongings</td>
<td>Ctrl+Alt+B</td>
</tr>
<tr>
<td>Orientation</td>
<td>Ctrl +Alt+O</td>
</tr>
<tr>
<td>Vital Signs</td>
<td>Ctrl +Alt+U</td>
</tr>
<tr>
<td>View Text</td>
<td>Ctrl +Alt+V</td>
</tr>
</tbody>
</table>
Go to radiogroup

The Go to radiogroup: is designed to navigate the templates with keyboard commands, when the mouse stops working during a patient assessment. It also satisfies the 508-compliant requirement, under Section 508 of the Rehabilitation Act, to be able to navigate the templates without using a mouse.

Go button

1. Use the Tab key to move to the bottom of the page.
2. Use the arrow keys to move up/down in the Go to radiogroup: list.
3. Click Go.

or

1. Click the drop-down arrow in the Go to radiogroup: drop-down list.
2. Select a radiogroup.
3. Click Go.
Navigating the Admission - Nursing Data Collection Tabs

The Admission – Nursing Data Collection template has four tabs. It can be part of the Admission – RN Assessment template or as a standalone template.

Belongings (Belong)

The Belongings tab contains information about items the patient brought to the hospital, disposition of the items, and items that the patient took home.

1. Admission – Nursing Data Collection opens to the Belongings (Belong) tab, Bel Page 1.

![Admission - Nursing Data Collection, Belongings (Belong) tab, Bel Page 1 window]

Does patient have items to inventory/Not at this time
Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 1 window

Does patient have items to inventory/Yes

2. Populate Bel Page 1.
3. Select Yes or No in the Does patient have items to inventory radiogroup.
   - If you select No, go on to another tab.
   - If you select Yes, additional fields are made available.
     i. Make appropriate selections on Bel Page 1.
     ii. Click Print to print the page.
4. Click Bel Page 2. Bel Page 2 displays.

Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 2 window

5. Populate Bel Page 2.
   a. Complete all the fields with asterisks; they are required fields.
   b. Click Print to print the page.
6. Click Bel Page 3.
   Bel Page 3 displays.

![Bel Page 3 Window](image.png)

**Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 3 window**

7. Populate Bel Page 3.
   a. Complete all the fields with asterisks; they are required fields.
   b. Click **Print** to print the page.
8. Click Bel Page 4.
Bel Page 4 displays.

Admission – Nursing Data Collection, Belongings (Belong) tab, Bel Page 4 window

   a. Complete all the fields with asterisks; they are required fields.
   b. Click Print to print the page.
# Orientation to Unit (Orient)

The Orientation to Unit tab allows you to indicate the unit areas to which you oriented the patient.

1. Click **Orient**.
   
   Orient window displays.

   ![Orient Window](image)

   **Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window**

2. In the Patient/family/support person oriented to unit list box, select:
   - **Yes** - patient oriented to unit or
   - **Yes** - family/support person oriented to unit
   - **No** - patient unable to respond
   - **No** - family/support person available

   Oriented to list box displays with a list of orientation activities.

   ![Oriented to List Box](image)

   **Admission – Nursing Data Collection, Orientation to Unit (Orient) tab window**

   Yes - patient oriented to unit
3. In the Oriented to list box, select one or more areas to which you oriented the patient.
Vital Signs (V/S)

The Vital Signs tab allows you to document the patient’s vital signs at admission. The vital signs include temperature, pulse, respiration, blood pressure, height, weight, pain, pulse oximetry, and circumference/girth.

Note: When you click Upload Vitals, vital signs are uploaded immediately into the Vitals package.

1. Click V/S.
   V/S displays.
   a. Complete all the fields with asterisks; they are required fields.
   b. Click each Click to enter qualifiers, to select qualifiers for each of the vitals.

   Note: Remember to enter units where appropriate.

   Example
   
   • Entering the temperature, depending on the type of thermometer used, select C for Centigrade or F for Fahrenheit.
   • Entering the height and weight, depending on the instruments used, select CM or IN and KG or LB.
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Temp

Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Pulse
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Resp

Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - BP
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers – Height

Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers – Weight
Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers – Pulse Ox

Admission – Nursing Data Collection, Vitals (V/S) tab window, Qualifiers - Circumference
2. Click **Save Qualifiers**, after selecting qualifiers for the individual vitals.
3. To remove incorrect qualifiers entered in error, click **Cancel before saving**.
4. Click **Upload Vitals**.
   Information pop-up displays.

   ![Information pop-up: Vitals will now be uploaded.]

   Information pop-up: Vitals will now be uploaded.

5. Click **OK**.
   Information pop-up displays.

   ![Information pop-up: Vitals uploaded!]

   Information pop-up: Vitals uploaded!

6. Click **OK**.
7. If you select the **Vitals cannot be taken at this time or the patient refused** check box, enter a reason in the *Why were vitals not taken* text box in the lower left corner of the page.

8. If you select the **Could not obtain height** and/or the **Could not obtain weight** check boxes at time of assessment, enter a reason in the *Why were vitals not taken* text box in the lower left corner of the page.
Admission – Nursing Data Collection, Vitals (V/S) tab window
Could not obtain height/Could not obtain weight
View Text (View Text)

The View Text tab is a review of all the information entered for a patient during data collection.

Admission – Nursing Data Collection, View Text Tab, after Upload

1. Click View Text.  
   The View Text window scrolls through the data collection for review.
2. Review the patient data.
3. Open the File menu and select Upload Data.  
   Upload results window displays.

Signing Note and Consults from within the Template

Note: Manage consults according to medical center policy. If nurses at your site do not order consults, upload a mandatory consult, but do not sign it.  
The identified provider will be notified that there is a consult to sign.

You can sign unsigned notes after the upload from the View Text tab in the template.

1. Click Close on the Upload results window.  
   Sign Note/Consults button displays.
Admission – Nursing Data Collection with Sign Note/Consults button

2. Click **Sign Note/Consults**.
   If the button does not display, upload again.

   ![Sign Note/Consults button](image)

   *Denotes a required field

   **Note:** If there is only a note to sign, the button is **Note**.
   If there is a consult to sign, the button is **Sign Note/Consults**.

3. Enter your electronic signature code and click **Accept e-sig**.
   Information pop-up displays, **Note signed!**.

4. Click **OK**.

5. To prevent the signing of an uploaded note, click **Cancel e-sig**.

   **Note:** It is safer to go to CPRS, read the note in CPRS, and sign the note in CPRS.
   - An unsigned note can be edited.
   - A signed note cannot be edited.
# Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADPAC</td>
<td>Automated Data Processing Application Coordinator</td>
</tr>
<tr>
<td>ART</td>
<td>Adverse Reactions Tracking</td>
</tr>
<tr>
<td>BCE</td>
<td>Bar Code Expansion</td>
</tr>
<tr>
<td>BCE-PPI</td>
<td>Bar Code Expansion-Positive Patient Identification</td>
</tr>
<tr>
<td>BCMA</td>
<td>Bar Code Medication Administration</td>
</tr>
<tr>
<td>Belong</td>
<td>Belongings</td>
</tr>
<tr>
<td>CAC</td>
<td>Clinical Application Coordinator</td>
</tr>
<tr>
<td>CIWA</td>
<td>Clinical Institute Withdrawal Assessment.--CIWA</td>
</tr>
<tr>
<td>Class 1 (C1)</td>
<td>Software produced inside of the Office of Enterprise Development (PD)</td>
</tr>
<tr>
<td></td>
<td>organization</td>
</tr>
<tr>
<td>Class 3 (C3)</td>
<td>Also known as Field Developed Software</td>
</tr>
<tr>
<td></td>
<td>Refers to all VHA software produced outside of the Office of Enterprise</td>
</tr>
<tr>
<td></td>
<td>Development (PD) organization</td>
</tr>
<tr>
<td>CMS</td>
<td>Centers for Medicaid and Medicare Services</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial Off the Shelf</td>
</tr>
<tr>
<td>CP</td>
<td>Care Plan</td>
</tr>
<tr>
<td>CPRS</td>
<td>Computerized Patient Record System</td>
</tr>
<tr>
<td>CV</td>
<td>Cardiovascular Assessment</td>
</tr>
<tr>
<td>Delphi</td>
<td>Programming language used to develop the CPRS chart</td>
</tr>
<tr>
<td>DFN</td>
<td>Data File Number</td>
</tr>
<tr>
<td>DP</td>
<td>Discharge Planning</td>
</tr>
<tr>
<td>Educ</td>
<td>Educational Assessment</td>
</tr>
<tr>
<td>Func</td>
<td>Functional Assessment</td>
</tr>
<tr>
<td>Gen Inf</td>
<td>General Information tab</td>
</tr>
<tr>
<td>GI</td>
<td>Gastrointestinal Assessment</td>
</tr>
<tr>
<td>GU</td>
<td>Genitourinary Assessment</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>ICD</td>
<td>International Classification of Diseases</td>
</tr>
<tr>
<td>ICN</td>
<td>The patient’s national identifier, Integration Control Number</td>
</tr>
<tr>
<td>IDPA</td>
<td>Interdisciplinary Patient Assessment - involves multiple disciplines</td>
</tr>
<tr>
<td></td>
<td>responsible for assessing the patient from their perspective and expertise.</td>
</tr>
<tr>
<td>IDPC</td>
<td>Interdisciplinary Plan of Care - The entry of treatment plans by multiple</td>
</tr>
<tr>
<td></td>
<td>disciplines to meet JCAHO requirements</td>
</tr>
<tr>
<td>IV</td>
<td>Intravenous</td>
</tr>
</tbody>
</table>

Admission - Nursing Data Collection User Manual
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IV Central</td>
<td>Central IV lines</td>
</tr>
<tr>
<td>IV Dialysis</td>
<td>IV Dialysis ports</td>
</tr>
<tr>
<td>IV Periph</td>
<td>IV Peripheral lines</td>
</tr>
<tr>
<td>JCAHO</td>
<td>Joint Commission on Accreditation of Healthcare Organizations</td>
</tr>
<tr>
<td>LPN</td>
<td>Licensed Practical Nurse</td>
</tr>
<tr>
<td>M/S</td>
<td>Musculoskeletal Assessment</td>
</tr>
<tr>
<td>MAS</td>
<td>Medical Administration Service</td>
</tr>
<tr>
<td>MH</td>
<td>Mental Health Assessment</td>
</tr>
<tr>
<td>MRSA</td>
<td>Methicillin-Resistant Staphylococcus Aureus</td>
</tr>
<tr>
<td>NAA</td>
<td>Nursing Admission Assessment</td>
</tr>
<tr>
<td>Neuro</td>
<td>Neurological Assessment</td>
</tr>
<tr>
<td>NHIA</td>
<td>Nursing Healthcare Informatics Alliance</td>
</tr>
<tr>
<td>NPAT</td>
<td>National Patient Assessment Templates</td>
</tr>
<tr>
<td>NUPA</td>
<td>Namespace assigned to the Patient Assessment Documentation Package (PADP) by Database Administrator</td>
</tr>
<tr>
<td>OED</td>
<td>Office of Enterprise Development</td>
</tr>
<tr>
<td>OERR</td>
<td>Order Entry Results Reporting</td>
</tr>
<tr>
<td>OIT</td>
<td>Office of Information and Technology</td>
</tr>
<tr>
<td>ONS</td>
<td>Office of Nursing Services</td>
</tr>
<tr>
<td>Orient</td>
<td>Orientation to Unit</td>
</tr>
<tr>
<td>P/S</td>
<td>Psychosocial Assessment</td>
</tr>
<tr>
<td>PADP</td>
<td>Patient Assessment Documentation Package</td>
</tr>
<tr>
<td>Pain</td>
<td>Pain Assessment</td>
</tr>
<tr>
<td>PC</td>
<td>Plan of Care</td>
</tr>
<tr>
<td>PCE</td>
<td>Patient Care Encounter</td>
</tr>
<tr>
<td>PD</td>
<td>Product Development</td>
</tr>
<tr>
<td>PHR</td>
<td>Patient Health Record</td>
</tr>
<tr>
<td>Prob</td>
<td>Problems/Interventions/Desired Outcomes tab in the RN Reassessment</td>
</tr>
<tr>
<td>Resp</td>
<td>Respiratory Assessment</td>
</tr>
<tr>
<td>Rest (or Restr)</td>
<td>Restraints</td>
</tr>
<tr>
<td>RN</td>
<td>Registered Nurse</td>
</tr>
<tr>
<td>RPC</td>
<td>Remote Procedure Call</td>
</tr>
<tr>
<td>RSD</td>
<td>Requirements Specification Document</td>
</tr>
<tr>
<td>Section 508</td>
<td>Under Section 508 of the Rehabilitation Act, as amended (29 U.S.C. 794d)</td>
</tr>
<tr>
<td></td>
<td>Public Law 106-246 (<a href="http://va.gov/accessible">http://va.gov/accessible</a>) agencies must provide employees and members of the public who have disabilities access to electronic and information technology that is comparable to the access available to employees and members of the public who are not individuals with disabilities</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Skin</td>
<td>Skin Assessment</td>
</tr>
<tr>
<td>SNOMED – CT</td>
<td>Systemized Nomenclature of Medicine Clinical Terms</td>
</tr>
</tbody>
</table>
| TIU             | Text Integration Utilities Program  
All text in CPRS is stored in TIU                                                                                          |
| TJC             | The Joint Commission                                                                                                                    |
| V/S             | Vital Signs                                                                                                                             |
| VA              | Department of Veterans Affairs                                                                                                           |
| VAMC            | Department of Veterans Affairs Medical Center                                                                                           |
| VANOD           | VA Nursing Outcomes Database                                                                                                             |
| VHA             | Veterans Health Administration                                                                                                            |
| VistA           | Veterans Health Information Systems and Technology Architecture  
An enterprise-wide information system built around an electronic health record used throughout the Department of Veterans Affairs medical system. |
| Vital Qualifiers| Provide detail in to the unit of measurement used with the vital signs.  
Height in inches or centimeters?  
Weight in pounds or kilograms? |

For additional PADP information, refer to the user manuals for Admission – RN Assessment, RN Reassessment, and Interdisciplinary Plan of Care.

**Documentation for NUPA Version 1.0 is also available on**

- VA Software Documentation Library in the Clinical Section
  [http://www4.va.gov/vdl/](http://www4.va.gov/vdl/)
- PADP SharePoint for NUPA Version 1.0
  [http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development](http://vaww.oed.portal.va.gov/programs/class3_to_class1/padp/field_development)